LIMITED WARRANTY ON MEDIA AND REPLACEMENT

If you discover physical defects in the manuals distributed with an Apple product or in the media on which a software product is distributed, Apple will replace the media or manuals at no charge to you, provided you return the item to be replaced with proof of purchase to Apple or an authorized Apple dealer during the 90-day period after you purchased the software. In addition, Apple will replace damaged software media and manuals for as long as the software product is included in Apple’s Media Exchange Program. While not an upgrade or update method, this program offers additional protection for up to two years or more from the date of your original purchase. See your authorized Apple dealer for program coverage and details. In some countries the replacement period may be different; check with your authorized Apple dealer.

ALL IMPLIED WARRANTIES ON THE MEDIA AND MANUALS, INCLUDING IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF THE ORIGINAL RETAIL PURCHASE OF THIS PRODUCT.

Even though Apple has tested the software and reviewed the documentation, APPLE MAKES NO WARRANTY OR REPRESENTATION, EITHER EXPRESS, OR IMPLIED, WITH RESPECT TO SOFTWARE, ITS QUALITY, PERFORMANCE, MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. AS A RESULT, THIS SOFTWARE IS SOLD "AS IS," AND YOU, THE PURCHASER, ARE ASSUMING THE ENTIRE RISK AS TO ITS QUALITY AND PERFORMANCE.

IN NO EVENT WILL APPLE BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM ANY DEFECT IN THE SOFTWARE OR ITS DOCUMENTATION, even if advised of the possibility of such damages. In particular, Apple shall have no liability for any programs or data stored in or used with Apple products, including the costs of recovering such programs or data.

THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHERS, ORAL OR WRITTEN, EXPRESS, OR IMPLIED. No Apple dealer, agent, or employee is authorized to make any modification, extension, or addition to this warranty.

Some states do not allow the exclusion or limitation of implied warranties or liability for incidental or consequential damages, so the above limitation or exclusion may not apply to you. This warranty gives you specific legal rights, and you may also have other rights which vary from state to state.
Apple Computer, Inc.

This manual and the software described in it are copyrighted, with all rights reserved. Under the copyright laws, this manual or the software may not be copied, in whole or part, without written consent of Apple, except in the normal use of the software or to make a backup copy of the software. The same proprietary and copyright notices must be affixed to any permitted copies as were affixed to the original. This exception does not allow copies to be made for others, whether or not sold, but all of the material purchased (with all backup copies) may be sold, given, or loaned to another person. Under the law, copying includes translating into another language or format.

The Apple logo is a registered trademark of Apple Computer, Inc. Use of the “keyboard” Apple logo (Option-Shift-k) for commercial purposes without the prior written consent of Apple may constitute trademark infringement and unfair competition in violation of federal and state laws.

© Apple Computer, Inc., 1991
20525 Mariani Avenue
Cupertino, CA 95014-6299
(408) 996-1010

Apple, the Apple logo, APDA, AppleShare, AppleTalk, EtherTalk, HyperCard, ImageWriter, LaserWriter, LocalTalk, Macintosh, StyleWriter, and TokenTalk are trademarks of Apple Computer, Inc., registered in the United States and other countries.

Balloon Help is a trademark of Apple Computer, Inc.

Adobe, Adobe Illustrator, and PostScript are registered trademarks of Adobe Systems, Inc.

Hayes is a registered trademark of Hayes Microcomputer Products, Inc.

ITC Garamond and ITC Zapf Dingbats are registered trademarks of International Typeface Corporation.

Microsoft is a registered trademark of Microsoft Corporation.

QuarkXPress is a registered trademark of Quark, Inc.

Simultaneously published in the United States and Canada.

Mention of third-party products is for informational purposes only and constitutes neither an endorsement nor a recommendation. Apple assumes no responsibility with regard to the performance of these products.
Contents

Introduction / 1
About this guide / 2
On-screen help / 3
For more information / 3
What you need to get started / 4
Installing AppleTalk Remote Access on your computer / 4

1 Answering Calls With Remote Access / 7
Indicating your modem setup / 8
Setting up Remote Access to answer calls / 10
Preventing users from calling your Macintosh / 12
Registering users / 13
   Naming a registered user / 13
   Setting a registered user's password and allowing a user to call / 14
Allowing guests to call your Macintosh / 17
Monitoring and disconnecting a user / 18
Quitting the Remote Access program / 19
2 Calling With Remote Access / 21
   Setting up Remote Access to make calls / 22
      Creating a connection document / 23
      Changing or deleting connection information / 26
      Connecting as a guest / 27
      Connecting to a remote Macintosh or network / 28
      Other ways to connect / 29
      Viewing your connection status / 30
   Selecting remote network services / 31
   Disconnecting from the remote network / 32
   Quitting the Remote Access program / 33

3 Security and Efficiency Considerations / 35
   Using the Activity Log / 36
      Copying, saving, and clearing the Activity Log / 37
   Maintaining security for your Macintosh and network / 38
      Register users / 38
      Don't allow guest access / 38
      Avoid saving your password / 39
      Limits to connection attempts / 39
      Select callback / 39
      Deny access to the network / 40
      Require a password to set up answering on the network / 41
   Using Remote Access efficiently / 42
      Connecting efficiently / 42
      Selecting remote network services only / 43
Appendix A  Using Modems With AppleTalk Remote Access  /  45

Modems you can use with Remote Access  /  45
  If your modem is not included  /  46
  Writing modem scripts  /  47
Connecting your modem  /  47
Modem commands  /  48
  Pulse dialing  /  49

Appendix B  Troubleshooting  /  51

Index  /  55
AppleTalk Remote Access is software that lets your Macintosh computer communicate with another Macintosh or an AppleTalk network over standard telephone lines, giving you convenient and direct access to information and resources at a remote location. For example, if you're away from your office but need to get a file from your Macintosh there, Remote Access can make the connection between your home and office computers. When you use Remote Access to call your office computer from your Macintosh at home (or wherever you're using a Macintosh with a modem), you can use Macintosh file sharing to access the files you need.

AppleTalk Remote Access lets you go beyond using just the resources of one computer—if the Macintosh you call is connected to an AppleTalk network, you can take advantage of all the services available on the remote network. For example, you can check your electronic mail, access files on AppleShare file servers, or print to a LaserWriter printer on the network. You can also access host services from your Macintosh, using gateways on the network.
About this guide

This guide explains how to install and use the AppleTalk Remote Access software. This introductory chapter tells you what you need to get started and provides you with instructions on how to install the software. Chapters 1 and 2 detail how to set up and use Remote Access. Chapter 3 tells you how to keep information on your network secure and how to monitor Remote Access activities. Appendix A provides information on using modems with Remote Access. Appendix B contains troubleshooting suggestions.

This guide assumes you are already familiar with the Macintosh desktop as well as with basic Macintosh skills, such as using the mouse and using the Chooser. If you’re unfamiliar with these skills, refer to the manuals that came with your computer.
You should also understand basic networking concepts and have experience using network services like electronic mail, file servers, and printers. For more information on the networking features of your Macintosh, see the networking chapter in the *Macintosh User's Guide* or in your System 7 documentation.

**On-screen help**

AppleTalk Remote Access includes on-screen information that you can consult when you need help. Balloon Help is a feature of System 7 that explains the function or significance of items you see on the Macintosh screen. To turn on Balloon Help, pull down the Help menu from the Help icon (the question mark) near the right end of the menu bar, and choose Show Balloons. When you point to an item on your screen, a balloon with explanatory text appears next to the item. To turn off Balloon Help, choose Hide Balloons from the Help menu. You can also choose Remote Access Information from the Help menu. Remote Access Information provides you with a series of on-screen cards that explain how to use Remote Access.

**For more information**

If you want more information about networks and networking, see the following books from Apple Computer (published by Addison-Wesley Publishing Company and available at your local bookstore):

- *Understanding Computer Networks* describes networking basics, including types of networks, network components, network media, and telecommunications.
- *The AppleTalk Network System Overview* provides a technical introduction to the structure and implementation of the AppleTalk network system protocols.
- *Planning and Managing AppleTalk Networks* explains in detail how to administer a small- to medium-sized AppleTalk network.
What you need to get started

To use AppleTalk Remote Access, your Macintosh computer must be running system software version 7.0 or later with at least two megabytes of memory, although four megabytes are recommended. You also need an appropriate Hayes-compatible modem with a data rate of at least 2400 bits per second (bps). See Appendix A for more information on which modems you can use with AppleTalk Remote Access. The Macintosh computer you call must also have AppleTalk Remote Access software installed and a modem attached.

If you received AppleTalk Remote Access in the box with your computer, your package includes:
- one 1.4 MB (high-density) disk, titled Installer
- this manual, the AppleTalk Remote Access User's Guide

If you purchased AppleTalk Remote Access from an authorized Apple reseller, your package includes:
- two 800K disks, titled Installer Disk 1 and Installer Disk 2
- this manual, the AppleTalk Remote Access User's Guide

The Installer disk (or disks) include the software and the Installer program that you'll use to install AppleTalk Remote Access software on your Macintosh.

Installing AppleTalk Remote Access on your computer

Follow the steps in this section to install the Remote Access software on your computer.

- **Note** The following instructions assume your computer has a floppy disk drive. If you don't have a floppy disk drive, you can install over a network or directly from a desktop Macintosh. See your Macintosh User's Guide for more information.
1 Insert the disk Installer (or Installer Disk 1) into your floppy disk drive and double-click the Installer icon to open the program.

The Installer prompts you to identify the software you want to install and the disk where you want to install it.

2 Select the disk where you want to install Remote Access, then click Install.

The installation process begins. If you're installing from two 800K disks, the Installer will prompt you to insert Installer Disk 2 before continuing.

The Installer cannot install Remote Access software on your Macintosh if any application programs are open. You'll receive a prompt if you have any programs open, and you can choose to quit the open programs and continue the installation process or to cancel the installation process.

When the Installer has finished, a dialog box appears to let you know that the installation was successful.

3 Click Restart to restart your computer.

Installation is now complete. The Remote Access icon appears on the disk directory, while other components of AppleTalk Remote Access reside in your System Folder. Later, you'll use these other components to set up connection information.
1 Answering Calls
With Remote Access

Once you've installed AppleTalk Remote Access software on your Macintosh, you can allow other users to call your computer and, through Macintosh file sharing, you can share and exchange files. If your computer is connected to an AppleTalk network, other users can also access all of the services your network provides, such as file services and electronic mail. Remote users can even use the LaserWriter printers connected to your network. You still have full use of your computer while it answers a call from another user and doesn't need the Remote Access program to be open in order to answer calls—Remote Access will answer automatically in the background. This chapter describes how to set up Remote Access for your Macintosh to answer calls.
Indicating your modem setup

Before your Macintosh can answer calls, you need to connect your computer to an appropriate modem. See Appendix A for a list of modems that you can use with AppleTalk Remote Access, as well as what to do if your modem isn't among those listed. Though you can use a modem capable of transmitting at least 2400 bps, Apple recommends that you use a 9600-bps modem.

The documentation that came with your modem will explain how to set up the modem for use with your computer. Once you've properly connected the modem, you need to register modem information with Remote Access. Follow the steps in this section to indicate your modem setup to the AppleTalk Remote Access software. Make sure you've already installed the Remote Access software according to the instructions in the Introduction.

1. **Double-click the Remote Access icon to open the program.**

   ![Remote Access Icon](image)

   An untitled connection document appears. Ignore this for now, because it's used to call another Macintosh; you'll work with connection documents in Chapter 2.

2. **From the Setup menu, choose Remote Access Setup.**

   ![Setup Menu](image)

   The Remote Access Setup control panel opens. The top portion of the control panel is where you indicate your modem setup.
• Note Another way to open the Remote Access Setup control panel is to choose Control Panels from the Apple () menu, then double-click the Remote Access Setup control panel.

3 Choose your modem type from the Modem pop-up menu.
Press the Modem pop-up menu. Drag through the list and choose the name of your modem. If your modem doesn't appear, refer to Appendix A for further information.
4 Choose the port to which your modem is connected from the Port pop-up menu.

If you don't know which port your modem is connected to, look at the back of your Macintosh. The port where the modem is connected has an icon above it, which looks like the Modem or Printer port shown in the following figure.

![Remote Access Setup](image)

Setting up Remote Access to answer calls

The Remote Access Setup control panel is where you set up Remote Access so your Macintosh can answer calls. Using the lower half of the control panel, you answer calls from users, limit access, and set connection time limits. Follow these steps to set up Remote Access so that other users can call your Macintosh.

1 If the Remote Access Setup control panel isn’t open, choose Remote Access Setup from the Setup menu.

2 Click the “Answer calls” checkbox.

- Answer calls
An X should appear in the checkbox to indicate you’ve selected this option. This lets your Macintosh answer calls from registered users. (Registering individual users is covered later in this chapter.) When this option is selected and your phone rings, your Macintosh answers the call, even if the Remote Access program is not open.

- **Note** If you have a service on your phone such as call waiting, then a second incoming call will disconnect you. Contact your local phone company to find out how to turn off call waiting while you use Remote Access.

3. **Click the “Maximum connection time” checkbox, then set the maximum connection time in minutes.**

![Maximum connection time: 90 minutes]

To ensure that remote connections aren’t left idle for a long period of time, you can set your Macintosh to disconnect calls after a certain amount of time. The amount of time depends upon what you expect people to do. Make sure to account for slower transmission rates and to allow users enough time to complete procedures.

When this feature is selected, a user who has called your Macintosh can remain connected for the time specified. The user receives a warning ten minutes before being disconnected, another warning five minutes before, and another warning two minutes before being disconnected. Your Macintosh disconnects the call when the maximum time period, as specified in the box, has passed.

- **Note** If you do not select this option, the user can remain connected for an unlimited period of time. However, you can disconnect a user directly (rather than by specifying a time limit), as discussed in the section “Monitoring and Disconnecting a User” later in this chapter.
4 Make sure you allow access to the entire network.

Allow access to:  ☐ entire network

Do you want callers to have access to all the services on the network to which your computer is connected? If so, the “entire network” button should be highlighted. Otherwise, callers have access only to your Macintosh and the services available on it, such as folders you’ve shared through file sharing.

5 Close the Remote Access Setup control panel.

Preventing users from calling your Macintosh

Follow these steps to prevent all users from calling your Macintosh:

1 Double-click the Remote Access icon to open the program, if necessary.

2 From the Setup menu, choose Remote Access Setup.

3 Click the “Answer calls” checkbox.

☐ Answer calls

Now, no one will be able to call your Macintosh. If you want to prevent access by specific users, you need only revoke their access privileges. This procedure is covered later in this chapter, in the section “Naming a Registered User.”
Registering users

By registering users, you let specific users call your Macintosh. You identify each user and give each a password; if you choose, you can also allow guests to call, as explained later in this chapter. Before any user or guest can call, a corresponding user or guest icon must exist in the Users & Groups control panel on your Macintosh.

⚠️ Important Remote Access uses the same User & Groups control panel as that used for Macintosh file sharing and program linking. If you’ve already set up a user for file sharing, use the same user icon to set up the user’s remote access to your computer.

Naming a registered user

The Remote Access software automatically sets up a user file for you, the Macintosh owner, using the owner name specified in the Sharing Setup control panel for Macintosh file sharing. If you aren’t using file sharing, you’ll need to set up a user file for yourself according to the instructions in this section. You can register as many as 100 users.

Follow these steps to register a user:

1. Open the Remote Access program, if necessary.

2. Choose Users & Groups from the Setup menu.

   ![Screenshot of Apple menu with highlighted Users & Groups option]

   You can also choose Control Panels from the Apple menu, as you normally would to access any control panel, then double-click the Users & Groups icon.
3 Choose New User from the File menu.

An icon titled New User appears.

4 Type the name of the person you want to register.

This name must match the spelling the user enters to call this Macintosh, but capitalization doesn't matter. Make sure you notify the user of the exact name you type.

Setting a registered user's password and allowing a user to call

Assigning passwords to registered users is one way of making sure that only authorized callers can gain access to your computer.

1 Open a user icon in the Users & Groups control panel.

Double-click the user icon you just created. That user's Remote Access options are displayed at the bottom of the window, under the options for file sharing and program linking. For information on file sharing and program linking, refer to the Macintosh User's Guide or your System 7 documentation.
2 **Type a password in the User Password text box.**

This password is what the user must enter to call your Macintosh. The password can be up to eight characters long. Make sure to inform the user of the exact password, including capitalization.

3 **Click the “Allow user to dial in” checkbox.**

- Allow user to dial in

This lets the user call your Macintosh. Later, if you want to revoke this user's access, you can click the checkbox again to deselect this option.
Click the “Call back at #” checkbox and type in the user’s telephone number.

Selecting this option means that when the user calls your Macintosh, your Macintosh will temporarily disconnect the user, then immediately call the user back at the number you’ve entered. The callback feature is optional; it provides an extra level of security, because the user must call from a predetermined phone number.

The callback number is the telephone number from which the user is calling. You enter the phone number as if you were dialing directly. If your Macintosh needs to dial an outside line (as in many business phone systems), type the outside line number followed by a comma. For example, type 9,555-1234. Type in the area code, if necessary, and enter international phone numbers in the same way. You can type hyphens in the number to make it easier to read, but it is not necessary. Also, if you turn off the callback option, the phone number remains but is unused.

- **Note** Remote Access uses touch-tone dialing. For information on pulse dialing and other characters interpreted by the modem, refer to Appendix A.

Close the user window.

You’ll be asked whether to save the information. After you’ve saved the information, your Macintosh can answer calls from that user.
Allowing guests to call your Macintosh

AppleTalk Remote Access enables you to allow nonregistered users, called guests, to call your Macintosh. Unlike registered users, guests do not enter a user name or password when calling your Macintosh.

⚠️ **Important** When you allow guests to call your Macintosh, you dramatically reduce its security features. You cannot specify a password or turn on the callback option for guest users. It is strongly recommended that you do not allow guests if your network contains sensitive information. For more information on security, refer to Chapter 3. ⚠️

Follow these steps to set up a guest user:

1. **Open the Remote Access program, if necessary.**
2. **Choose Users & Groups from the Setup menu.**
3. **Double-click the <Guest> icon.**

The <Guest> user window opens, which contains information similar to other user windows. The Remote Access options are displayed at the bottom of the window, under the options for file sharing and program linking.
4 Click the “Allow guests to dial in” checkbox.
Selecting this option lets guest users call your Macintosh. Later, if you want to prevent
guests from calling, click this option again to deselected it.

5 Close the <Guest> window.
Now the Macintosh will accept calls from any guest.

Monitoring and disconnecting a user

When a user calls your Macintosh, the Remote Access Status window displays the user’s
name and how long the user has been connected. You also use the Remote Access Status
window to disconnect a user.

1 Choose Status from the Windows menu to view the Remote Access Status
window.

This icon indicates your Macintosh has
answered a call.

Click here to disconnect a user.

2 Click Disconnect to disconnect the user.
3 Type the number of minutes that you want to elapse before the user is disconnected.

Enter 0 to disconnect the user immediately.

![Disconnect user dialogue box](image)

4 Click OK.

The Remote Access Status window displays the time remaining until the user is disconnected. The user receives a message indicating the amount of time prior to disconnection. The user also receives warning messages 10 minutes, 5 minutes, and 2 minutes before being disconnected, if enough time is allowed.

After you begin the disconnection process, the Remote Access Status window displays a Cancel button. Clicking Cancel halts the disconnection process. The user then receives a message indicating that the disconnection process has been stopped, and the user can remain connected for the amount of time you’ve specified in the Remote Access Setup control panel.

## Quitting the Remote Access program

You can quit the Remote Access program at anytime by using the Quit command from the File menu. If a user is currently connected to your Macintosh, the connection remains open because quitting the Remote Access program has no effect on the connection. Quitting the program frees up memory for your computer to use for other processing.

You’ll need to reopen the program if you want to disconnect a user. Check the user’s status in the Remote Access Status window, or look at the Activity Log (discussed in Chapter 3). If you reopen the program while a connection is active, the Remote Access Status window automatically opens.
2 Calling With Remote Access

You can use AppleTalk Remote Access to call another Macintosh computer that also has Remote Access installed and is set up to answer your calls. If the other Macintosh is attached to an AppleTalk network, you'll have access to the remote network services as if your Macintosh is connected directly. To make calls, you first must install the AppleTalk Remote Access software and supply the necessary connection information.
Setting up Remote Access to make calls

Before you make a call, you need to do the following:

- Install the Remote Access software. Follow the installation procedures in the Introduction.

- Connect a modem to your Macintosh and indicate your modem setup in the Remote Access Setup control panel. Follow the instructions in “Indicating Your Modem Setup” in Chapter 1.

- Make sure that Remote Access software is installed on and a modem is connected to the Macintosh you want to call, and that you can call that Macintosh as a guest or registered user. If you didn’t set up the other Macintosh yourself, check with the computer’s owner or your network administrator to confirm that the Macintosh is set up to answer calls.

  If the Macintosh you’re calling allows registered users only, the other Macintosh must have your name and password in order to answer your call. Verify how your name and password were set by the computer’s owner, so that you enter matching information when you call. Also, if the other Macintosh uses callback, check that your telephone number is correct.

  To answer your call, the Macintosh you’re calling does not need the Remote Access program open. However, the other Macintosh and its modem must turned on.

- Obtain the telephone number of the modem connected to the Macintosh you want to call.

- Create a connection document, following the instructions in the next section.
Creating a connection document

The information that AppleTalk Remote Access needs to access another Macintosh computer is stored in a connection document. By using multiple connection documents, you can save the information needed to call different Macintosh computers.

1. If necessary, double-click the Remote Access icon to open the program.

![Remote Access Icon]

A new untitled connection document appears on your screen when you open the program. (If you're continuing from the previous chapter, you should have an untitled connection document on your screen.) You can also create a new untitled connection document by using the New command from the File menu.

2. Connect as a registered user.

You can call another Macintosh as a registered user or as a guest. When you open a new connection document, the Registered User button is selected automatically. Connecting as a guest is covered in the section “Connecting as a Guest” later in this chapter.
3 Enter your user name in the Name text box, if necessary, and press Tab.

If the cursor is not in the Name text box, tab to it or click in the box to place the cursor. Your user name must match the spelling that is registered with the Macintosh you want to call, but capitalization doesn’t matter.

If you’ve specified an owner name for file sharing, the owner name appears automatically in the Name text box of the connection document.

4 Type your password in the Password text box and press Tab.

Type in your password exactly as registered with the Macintosh you want to call. As you type, the characters appear as bullets (•) to prevent someone else from reading your password. You must match uppercase and lowercase letters exactly.

◆ Note If you attempt a connection with an incorrect password, an error message will appear and you can try again. However, as a security precaution, if you try to connect using an invalid password seven times consecutively, the other Macintosh will revoke your ability to make a connection. In this case, you’ll need your connection privileges reinstated on the Macintosh you’re trying to call. Check with the owner of the other Macintosh or your network administrator if you should need your privileges reinstated; that person must open your user icon in the Users & Groups control panel and reselect the option “Allow user to dial in.” ◆

5 Type the phone number of the Macintosh you want to call.

Enter the number as if you were dialing directly. For example, if the Macintosh is in area code 818 and its phone number is 555-1234, type:

1, 818-555-1234

A comma in the phone number designates a pause. You can use dashes for readability, but the program doesn’t require them. Also, Remote Access assumes you’re dialing from a touch-tone phone. For information on pulse dialing and commands interpreted by the modem, refer to the section “Modem Commands” in Appendix A.
Important The option “Save my password” lets you save your password in the connection document. If you save your password, you won’t need to enter it whenever you connect. However, this compromises the security of the computer you’re calling, because anyone can then use your connection document to connect. For a discussion of security considerations, including passwords, refer to Chapter 3, “Security and Efficiency Considerations.” For now, leave this checkbox blank.

6 Click the “Remind me of my connection” checkbox if you want Remote Access to remind you periodically that you are connected to another Macintosh. Then type a number between 1 and 9999. This number tells Remote Access how often, in minutes, to remind you of the connection.

This feature helps you avoid unintentional or prolonged connections. After your computer is connected to another Macintosh for the specified period of time, you will receive a message asking if you want to continue your connection. If you click OK, your work will not be interrupted. If you do not respond within one minute, AppleTalk Remote Access will disconnect you.

At this point, the connection document should look something like the following:

You should now save the connection document, so you can use it later.
From the File menu, choose the Save As command to save the connection document.

Saving the connection document means you won't need to reenter the information when you next call the same Macintosh. You can use the Save As or Save command, or click the connection document's close box. You'll then receive a prompt to enter a name for the connection document. Pick a name that describes the Macintosh you're calling, like "Boston Office" or "Mac at home." The connection document icon will appear in the folder where it is saved. You can store connection documents wherever you like on your hard disk.

Changing or deleting connection information

After you've saved a connection document, double-click its icon to open it. You can edit any of the information previously entered and save it for later use.

To get rid of a connection document, drag it to the Trash and use the Empty Trash command in the Finder to delete it.
Connecting as a guest

To connect as a guest, open a connection document and click the Guest button.

The text boxes for Name and Password are unavailable, because you don't use those to connect as a guest. You can save the connection document as you would any connection document, so at some later time you can connect using the same information. Note that to connect as a guest, the Macintosh you're calling must allow guest access. Check with the owner of the Macintosh you're calling to find out if you can connect as a guest.
Connecting to a remote Macintosh or network

Once you've installed Remote Access and have created a connection document, you can make a call to another Macintosh.

1 Double-click a connection document icon.
   This opens the connection document and the Remote Access program.

2 Enter your password, if necessary.

3 Click Connect.
   When you click Connect, AppleTalk Remote Access calls the other Macintosh and tries to connect to it. The Remote Access Status window appears to allow you to cancel the connection attempt before the connection is completed and to show the progress of your connection.
The other Macintosh verifies your name and password, and the connection is then established.

- **Note** If the other Macintosh has callback turned on, you are temporarily disconnected from the other Macintosh while it attempts to call you back. Your phone will ring and the modem will answer the call. Then, the connection is established. Refer to Chapter 3 for more information on callback.

**Other ways to connect**

Another way you can open the Remote Access program is to drag the connection document onto the Remote Access icon.

This opens the Remote Access program and the connection document. You then click the Connect button in the connection document window to call another Macintosh.

As a shortcut, hold down the `⌘` key when double-clicking the connection document or when dragging the connection document onto the Remote Access icon. The program will then automatically try to connect using that connection document.
Viewing your connection status

Whenever the Remote Access program is open, you can view your connection status by looking at the Remote Access Status window. To open the window, choose the Status command from the Windows menu.

The Remote Access Status window appears, showing details of your connection.

The Remote Access Status window tells you where you're connected and for how long you've been connected. Also shown is the time remaining for your connection. The time limit is set by the owner of the Macintosh you've called, or you may have no time limit for your connection, indicated by the word “Unlimited.” You can click the close box to close the Remote Access Status window.

The Windows menu also contains the Activity Log command. The Activity Log contains a listing of all events involving Remote Access, such as connections made or attempted. Using the Activity Log is covered in Chapter 3.
Selecting remote network services

AppleTalk Remote Access allows you simultaneous use of the services of your local AppleTalk network as well as those of the network of the Macintosh you've called, provided the other Macintosh is set up to allow access to the remote network. Once you've established a connection to a remote AppleTalk network with Remote Access, you select network services in the Chooser window or use other network products such as electronic mail, following the same steps you would to use the service on your local network.

As an example, the following steps show how to print to a LaserWriter that's on a remote AppleTalk network. Let's say you have not yet used Remote Access to connect. Assuming your Macintosh has an AppleTalk network printer such as a LaserWriter attached, the Chooser window shows you the local services available to you:

![Chooser window showing laserwriter](image)

Now, call the other Macintosh, establishing a connection to the remote AppleTalk network.
1 **Look at the Chooser window.**

   The Chooser window displays the network services and AppleTalk zones that are currently available to you. Notice the LaserWriters available from the remote network:

![Chooser Window](image)

2 **Select a LaserWriter as you normally would, then close the Chooser.**

   You can now print to the remote LaserWriter.

### Disconnecting from the remote network

   Once you establish a connection with a remote network, the Remote Access Status window displays a Disconnect button.

1 **From the Windows menu, choose Status.**

2 **Click Disconnect.**

   When you click Disconnect, the connection between your computer and the other Macintosh is broken. However, the Remote Access program is still open, so you can make another connection or create a new connection document.
If for some reason you shut down your Macintosh while connected to a remote network, the connection is automatically broken.

**Quitting the Remote Access program**

You can quit the Remote Access program at any time by using the Quit command from the File menu. If you’re currently connected to a remote network, your connection remains established because quitting the program has no effect on the connection. Quitting the program frees up memory for your computer to use for other processing. You cannot quit if you’re in the process of connecting or disconnecting.

If you quit while you’re connected to a remote network, you’ll see a dialog box that reminds you of your connection. You must choose to disconnect and quit, stay connected and quit, or cancel.

![Dialog box](image)

Remember that you’ll need to reopen the program if you want to disconnect, open a connection document, or check your connection status in the Remote Access Status window. If you reopen the program while a connection is active, the Remote Access Status window automatically opens.
3 Security and Efficiency Considerations

To get the most out of AppleTalk Remote Access, you can take certain steps to make sure your Macintosh is secure and that you're using Remote Access efficiently. Remote Access provides several measures of security, including the ability to monitor users. This chapter discusses efficiency measures and Remote Access security along with general considerations for keeping your network secure.
Using the Activity Log

The Activity Log documents all Remote Access events. It keeps track of when a Remote Access connection is attempted, established, or disconnected, indicating if the connection is a connection you initiated or if another user called your Macintosh. The Activity Log retains the 1,000 most recent activities.

Follow these steps to view the Activity Log:

1. Double-click the Remote Access icon to open the program, if necessary.
2. From the Windows menu, choose Activity Log.

The Activity Log appears displaying the current and most recent activity of your Macintosh. The first column shows the date and time of the activity. A diamond (♦) preceding the first column indicates that your Macintosh established the connection by answering a call from another user. The second column displays the user name.

The third column describes the activity. An exclamation point (!) precedes the activity if an unusual event occurred. This alerts you to activities such as an unknown user trying to call or a user trying to connect with an incorrect password.
Copying, saving, and clearing the Activity Log

To save the Activity Log for your records, you can select the Activity Log entries and copy them to the Clipboard. Click the entry or Shift-click the range of entries you want to copy, or use Select All from the Edit menu, then use the Copy command from the Edit menu.

![Activity Log](image)

The entries are copied to the Clipboard as tab-delimited text, so you can paste this into a spreadsheet file. Use this spreadsheet file to save multiple records of the Activity Log, to sort and search through the information, or to print.

You can also save the Activity Log as a text file. To do this, choose Save As from the File menu. You'll be prompted to enter a name for the text file, which is saved on the disk you specify. By default, the text file is saved under the name Log, followed by a range of dates that correspond to the earliest and latest activities in the Activity Log. Use any word-processing or spreadsheet program to view or edit the text file.

Should you wish to clear the Activity Log completely, choose Clear Log from the Edit menu. A dialog box will appear, prompting you to confirm that you wish to clear the Activity Log. After you clear the Activity Log, those entries cannot be recovered, so you should save the log before clearing it.
Maintaining security for your Macintosh and network

Before allowing users to call your Macintosh, make sure you've established what information you want others to have access to. You should set up file sharing for those folders you want other people to use. If you do not use file sharing, a user can still call your Macintosh but will not have access to your computer's folders or hard disks.

If you want to call your own Macintosh, then turn on file sharing but do not share any folders. This way you, as the owner, always have access to all your files under file sharing.

If you are setting up Remote Access on a Macintosh that is part of an AppleTalk network, security is an especially important issue. Remote Access includes several features that provide security for your network. You can register users, use the callback option, and limit the access users have to the network.

Register users

When you call another Macintosh, you gain access to all public files, file servers, and printers on the network to which that Macintosh is connected (but only if the remote Macintosh is set up to allow access to the entire network). Each Macintosh using Remote Access stores the name and password of every user registered to call. Registered users are assigned passwords that they must enter each time they call the Macintosh. A user's name and password act as a key—no one can enter the network without knowing and entering both of them correctly. You should encourage users to change their passwords frequently.

Don't allow guest access

By allowing guests to call your Macintosh, you allow unknown users to access your network. If network security is a concern, then do not allow guest users to call.
Avoid saving your password

Avoid saving your password with your connection document (the “Save my password” checkbox should not be checked). If the password is saved, anyone can use that connection document to call the Macintosh that you are registered to use.

Limits to connection attempts

When a user calls a Macintosh, the user is allowed seven consecutive tries to enter the correct password. After seven incorrect password entries, the user's connection privileges are revoked and the Macintosh owner must set up the user again to call that computer. This seven-try limit helps prevent an unregistered user from guessing a password.

Select callback

After a user calls and is verified as a registered user, the Macintosh can temporarily break the connection and, using a phone number stored with the user's name, call the user back. This callback feature gives further assurance that the user is authentic, because the user must call from a predetermined phone number. You can set the callback option for each user in the user's information window in the Users & Groups control panel.
Deny access to the network

You can limit users' access to only the Macintosh called, preventing all users from accessing services on the remote network.

Allow access to entire network

Allow access to this Macintosh only

A caller's access is to the entire network.

A caller's access is limited to the answering Macintosh only.
To limit access, open the Remote Access Setup window. Click the button to allow access to “this Macintosh only.”

![Remote Access Setup window]

**Remote Access Setup**

- **Modem Setup**
  - Modem: Apple Modem 2400
  - Port:
  - Modem Speaker: On

- **Remote Access Answering Setup**
  - Answer calls
  - Maximum connection time: 0 minutes
  - Allow access to: entire network, this Macintosh only

**Require a password to set up answering on the network**

On a large network, the network administrator can require users to enter a password to set up answering on the network. Check with your administrator to see if this feature is implemented and to find out your network password. If the feature is implemented, you'll receive a dialog box when you set up your Macintosh to answer calls in the Remote Access Setup control panel.

![Password dialog box]

**Password:**

- Cancel
- OK

Maintaining security for your Macintosh and network 41
Using Remote Access efficiently

The following sections discuss how to use Remote Access efficiently and address special concerns for hardware setup.

Connecting efficiently

Remember that you are using standard telephone lines to connect to a remote network. Just as you are billed for your toll calls and long-distance calls, you are also billed if you call a Macintosh outside your local calling area.

If a Macintosh you're calling has the callback option turned on, the other Macintosh disconnects your call and immediately calls you back. The other Macintosh then originates the phone connection and becomes responsible for the charges.

The following guidelines can help keep your long-distance phone charges to a minimum:

- Disconnect as soon as you no longer need to use the remote network.
- Do not open programs such as word processors, spreadsheets, and graphics programs on the remote network. Because the program will run over telephone lines, commands may take an extraordinarily long time to complete.
- Prepare files as much as possible before you make a connection.
- Set a maximum connection time to limit users who call your computer.
- Use the option “Remind me of my connection.” This keeps you from forgetting about a connection, because you must respond to the prompt or Remote Access disconnects you.
- As soon as you finish using a file server volume, drag the volume to the Trash to disconnect from the server.
- While you’re using file server volumes, don’t leave their windows open. These windows are updated periodically causing unnecessary network traffic.
Selecting remote network services only

When AppleTalk Remote Access is installed, the Network control panel contains an additional icon called Remote Only. You use the Network control panel to select the type of network to which you want to connect locally. The default is LocalTalk, which uses the printer port on your Macintosh to connect to AppleTalk networks. You may also see other icons depending on your network setup.

You might select Remote Only for two reasons:

1. To turn off access to your local AppleTalk network (LocalTalk, EtherTalk, or TokenTalk), so you see only the remote network when you make a Remote Access connection.

Sometimes you can’t locate a service on the remote network because a service on your local network has the same address. This is similar to phone numbers, for which two people in different area codes may have the same seven-digit phone number. If you don’t specify the area code and dial only the seven-digit number, you call the person who is in the same area code as you. Selecting Remote Only is like dialing the area code, meaning you call the person outside your local area. When you select Remote Only, access to the local network is shut off, ensuring that all services on the remote network are accessible.
2. To turn off LocalTalk to free up the printer port on your Macintosh for other uses, such as printing to an ImageWriter or StyleWriter.

If you want to use your printer port for something other than LocalTalk, maybe to print to a StyleWriter or ImageWriter, you need to select Remote Only. This shuts off access to the local network, leaving the printer port free for another use. Since Remote Access is a type of AppleTalk connection, making AppleTalk inactive in the Chooser means you can't use Remote Access. So if you want to use Remote Access and the printer port, you need to select Remote Only.

Be aware that if your Macintosh is currently connected to a remote network and you switch from one AppleTalk connection type to another in the Network control panel, such as from LocalTalk or EtherTalk to Remote Only, you will be disconnected. However, you can always reconnect.
Appendix A: Using Modems
With AppleTalk Remote Access

AppleTalk Remote Access includes scripts to use many popular Hayes-compatible modems within the United States. This appendix lists the modems that have scripts included with the AppleTalk Remote Access software and discusses what you can do if your modem is not included. This appendix also shows how to connect a typical modem to your Macintosh and lists standard modem commands.

Modems you can use with Remote Access

AppleTalk Remote Access includes scripts for the following modems for use within the United States. If you're using AppleTalk Remote Access outside of the U.S., contact your authorized Apple reseller or representative for modem information. For the best performance, Apple suggests you use a 9600-bps modem.

2400 bps/V.22bis modems

- Apple Modem 2400 (supports all 2400-bps Apple modems)
- Abaton InterFax 24/96
- Global Village Teleport
- Hayes SmartModem 2400
- Microcom Microporite 1024
- Practical Peripherals 2400SA
- Prometheus ProModem 2400
- Supra SupraModem 2400
- US Robotics Courier 2400e

9600 bps/V.32 and 14400 bps/V.32bis modems
- DSI 9624 LE/LE Plus
- Hayes Ultra 96
- Farallon Remote V.32
- Microcom MacModem V.32
- MultiTech MultiModemV32
- Practical Peripherals 9600SA
- Prometheus ProModem Plus/Ultima
- Telebit T1600
- US Robotics Courier V.32bis

For every type of modem that Remote Access supports, a script resides in the Extensions folder within your System Folder. Modem scripts contain program code used by the Remote Access software to communicate with that particular modem type.

If your modem is not included
Your modem should conform to the CCITT (Comité Consultatif International Télégraphique et Téléphonique) standards V.22bis, V.32, or V.32bis. If you want to use Remote Access with a modem not listed above, a script may be available for your modem. Check with one of the following sources to see if a modem script is available:
- your modem vendor
- your authorized Apple reseller or representative
- the Apple Customer Assistance Center (1-800-776-2333 in the U.S.)
- if you’re a subscriber, the Apple Technical Coordinator Answerline or the Apple Software Development Answerline

Some modems not included with the Remote Access software may need a cable that supports CTS (Clear To Send). Call the Apple Customer Assistance Center for more information.
Writing modem scripts

If you understand connection control languages (CCLs) and are an experienced programmer, you may be able to write the necessary modem script yourself. The AppleTalk Remote Access Modem Toolkit is available through APDA (Apple Programmers and Developers Association). The kit includes a HyperCard stack and appropriate documentation to help you build scripts.

APDA offers convenient worldwide access to over 300 Apple and third-party development tools, resources, and information for anyone interested in developing applications on Apple platforms. To order products or get additional information contact:

APDA
Apple Computer, Inc.
20525 Mariani Avenue, M/S 33-G
Cupertino, California 95014-6299
800-282-2732 (United States)
800-637-0029 (Canada)
408-562-3910 (International)
408-562-3971 (Fax)
171-576 (TELEX)
AppleLink: APDA

Connecting your modem

How you set up your modem depends on the type of modem you’re using. The documentation that came with your modem should provide specific details on how to connect your modem to your computer. Depending on the type of modem or Macintosh you use, you’ll need to do the following:

- Connect your modem to your telephone line.
- Connect your modem to your telephone (optional).
- Connect your modem to your Macintosh.
- Connect a power supply to your modem.
The following picture offers a typical example that shows an Apple Data Modem connected to a Macintosh:

![Modem Diagram]

Modem commands

Standard commands are interpreted by most modems available in the United States. You enter these commands as characters in the telephone number sent to the modem. The following table lists standard commands, but you should refer to your modem manual for a complete description of the commands it interprets.

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-9, =, *</td>
<td>Digits and characters used for dialing.</td>
</tr>
<tr>
<td>T</td>
<td>Causes all digits following to be touch-tone dialed (the default).</td>
</tr>
<tr>
<td>P</td>
<td>Causes all digits following to be pulse dialed.</td>
</tr>
<tr>
<td></td>
<td>Pauses before continuing.</td>
</tr>
</tbody>
</table>

48 Appendix A Using Modems With AppleTalk Remote Access
**Pulse dialing**

AppleTalk Remote Access assumes you're dialing from a touch-tone phone. If you require pulse dialing, precede the number with a P, as shown here:

P1,818-555-1234

If you need a combination of pulse and touch-tone, precede the numbers with P (for pulse) and T (for touch-tone) as appropriate. You may need to do this if you're making a long distance call with pulse dialing, and you first connect to your long-distance carrier's lines then enter an access code using touch-tone. In this case, the phone number you enter should look something like this:

P1,818-555-1234 T342
Appendix B: Troubleshooting

While using AppleTalk Remote Access, you may occasionally encounter a problem. This appendix provides information that is common to most modems and offers suggestions for solving problems.

You can't make a call.

- Make sure your modem is connected properly and turned on. Refer to your modem documentation if you have any problems.
- Make sure your modem type and port are selected in the Remote Access Setup control panel.

Your modem is working, but you can't connect to another Macintosh.

- Make sure you're a registered user on the other Macintosh. Check that you've entered your user name and password correctly.
- Find out if the other Macintosh is set up to call you back, and verify that your telephone number is correct.
- Make sure the other Macintosh and its modem are turned on, and the Macintosh is set up to answer calls.
You are losing the connection.

- You may have noisy phone lines. Contact your phone company.
- Make sure you’ve selected the correct modem type in the Remote Access Setup control panel.
- The call-waiting feature can disrupt the connection when someone tries to call you. When you enter the phone number in the connection document, precede the number with the code to turn off call waiting. However, if the other Macintosh has callback turned on, your modem first hangs up, which reenables call waiting. Contact your phone company for information on how to turn off call waiting.

The response time from the remote network is slow.

- Make sure the Macintosh you’ve called is using a 9600-bps modem. Look in the Activity Log to check the speed the two modems are using.
- Refer to the section “Using Remote Access Efficiently” in Chapter 3 to see if you can save time during the connection.

After you connect to a remote network, you have problems with your ImageWriter or another device connected to the printer port.

- Select Remote Only in the Network control panel to redirect AppleTalk and allow you to print to your serial printer. Refer to the section “Selecting Remote Network Services Only” in Chapter 3 for more information.

After you connect to a remote network, you cannot access your local network.

- Select LocalTalk (or EtherTalk or TokenTalk) in the Network control panel to access your local network. Refer to the section “Selecting Remote Network Services Only” in Chapter 3 for more information.
Other programs that use the serial port don't function properly, you see a dialog box that says the serial port is in use, or your Macintosh freezes during shutdown.

- When the option “Answer calls” is selected in the Remote Access Setup control panel, the serial port is in use by Remote Access. To use other programs that need the serial port, turn off the option “Answer calls.”
- If your other program is incompatible with Remote Access, contact your authorized Apple Reseller for more information.
Index

A
access
  to entire network 12
  to the remote Macintosh only 41
Activity Log 36–37
copying, saving, and clearing 37
  use of 36–37
  in Windows menu 30
answering calls 7–19
guests calling Macintosh 17–18
preventing users from calling 12
setting up Remote Access for 10–12
APDA (Apple Programmers and
  Developers Association) 47
Apple Customer Assistance Center 46
Apple Software Development
  Answerline 46
AppleTalk Remote Access Modem
  Toolkit 47
Apple Technical Coordinator
  Answerline 46

B
Balloon Help 3

C
call back at 1 checkbox 16
callback feature 16
for security 39–40
troubleshooting 52
calling with Remote Access. See making
calls
call-waiting feature 11, 52
CCITT (Comité Consultatif International
  Télégraphique et Téléphonique)
  modem standards 46
Chooser, using 31–32
clearing Activity Log 37
Clipboard, saving Activity Log to 37
Comité Consultatif International
  Télégraphique et Téléphonique
  (CCITT) modem standards 46
connecting users. See also connection
document
guests 27
limits on connection attempts 24, 39
to remote Macintosh or network 28–30
viewing connection status 30
connection control languages (CCLs) 47
connection document 8
  creation of 23–26
deleting 26
editing 26
saving 26
shortcut for opening 29
connections. See also connecting users;
disconnections
  of modem 47–48
copying Activity Log 37
CTS (Clear to Send) cables 46

D
diamond (△) in Activity Log 36
disconnections. See also connections
calls 11
networks 32–33
users 18–19

electronic mail 2
EtherTalk
  Remote Only icon 43–44
troubleshooting 52
exclamation point (!) in Activity Log 36
Extensions folder, modem scripts in 46

F
file service 2
file sharing 2

G
guests
calling Macintosh 17–18
connecting as 27
security and 38
Hayes-compatible modem 4, 45, 46
help, on-screen 3
HyperCard stack for scripting 47

ImageWriters
troubleshooting 52
using Remote Access with 44
installer disk 4, 5
installing AppleTalk Remote Access 4-5

LaserWriters 7
steps to using 31-32
local networks. See EtherTalk; LocalTalk
LocalTalk
Remote Only icon 43-44
troubleshooting 52

making calls 21-33. See also connection
document
setting up for 22
maximum connection time checkbox 11
Modem pop-up menu 9
modems
commands 48
connection of 47-48
Hayes-compatible modem 4
indicating setup of 8-10
list of usable modems 45-46
terminal program and 53
troubleshooting for 51
modem scripts
in Extensions folder 46
writing of 47
monitoring users 18-19

name text box, connection document
and 24
networks. See also EtherTalk; LocalTalk;
security
connecting to remote network 28-30
denying access to 40-41
only remote network services 43-44
passwords to 41
Remote Only icon 43-44
secure network, answering on 41
selecting remote services 31-32
troubleshooting 52
9600 bps/V.32 and V.32bis modems 46

on-screen information 3

passwords 13
avoid saving 39
collection document using 24
guests and 17
network access 41
save my password option 25, 39
setting of 14-16
Port pop-up menu 9
preventing access 12
printers. See also ImageWriters;
LaserWriters
troubleshooting 52
pulse dialing 16, 49

quitting Remote Access program 19, 33

registering users 11, 13-16, 38. See also passwords
collection document and 23
naming registered user 13-14
remind me of my connection checkbox 25
Remote Access Setup control panel 9
Remote Access Status window 28-29, 30
remote Macintosh, connecting to 28-30
remote networks. See networks
Remote Only icon 43-44
response time from network,
troubleshooting for 52

save my password option 25
saving
Activity Log 37
connection document 26
security 38-41. See also Activity Log;
callback feature; passwords;
registering users
collection attempt limits 39
deny access to network 40-41
guests and 17, 38
setting up
to make calls 22
for modems 8-10
seven-try collection attempt limit 24, 39
Status command 30
StyleWriters, Remote Only icon with 44

television numbers. See also callback
feature
APDA (Apple Programmers and
Developers Association) 47
Apple Customer Assistance Center 46
in connection document 24
terminal program, troubleshooting for 53
touch-tone dialing 16, 49
troubleshooting 51-53
2400 bps/V.22bis modems 45-46

Users & Groups control panel 13
callback feature and 39

viewing connection status 30
The Apple Publishing System

*AppleTalk Remote Access User's Guide* was written, edited, and composed on a desktop publishing system using Apple Macintosh computers, an AppleTalk network system, Microsoft Word, and QuarkXPress. Line art was created with Adobe Illustrator. Proof pages were created on Apple LaserWriter printers. Final pages were output directly to film on an AGFA Compugraphic 9800. PostScript®, the LaserWriter page-description language, was developed by Adobe Systems, Inc.

Text and display type are Apple's corporate font, a condensed version of ITC Garamond. Bullets are ITC Zapf Dingbats. Some elements, such as program listings, are set in Apple Courier, a fixed-width font.